Exact Change
Contents

Introduction ................................................. 1
Installing the software ............................. 2
The series page ....................................... 4
Selecting favorite series ......................... 6
The pricing page ...................................... 8
Modifying the price list ............................ 9
The coins page ....................................... 10
The images page ..................................... 15
The reports page .................................... 17
The report bin ....................................... 19
The varieties page ................................. 21
The eBooks page .................................... 22
Loading and saving data .......................... 23
The options menu ................................... 25
Adding countries to your collection ........ 26
Erasing unused images ............................ 27
Using the Windows clipboard ................. 28
Customizing the program ....................... 29
The display menu .................................... 32
Collection themes ................................... 33
User defined fields ................................. 34
User defined grade scales ....................... 36
Finding a coin by item number ............... 38
Utilizing coin tracking ............................ 39
Search & track ....................................... 40
The bullion values calculator ............... 41
Converting Hebrew dates ....................... 42
Converting Arab dates ......................... 44
Converting Japanese dates ..................... 45
Other date converters ............................ 46
Converting Roman numbers ................. 48
The Wallpaper press ............................. 49

Published in the United States by

WILD MAN SOFTWARE
P.O. Box 545
Middletown, CA 95461
“What is Exact Change”?  

Exact Change provides you with the ability to easily record, track and report on items in your coin collection. Exact Change builds upon the information you enter, automatically adding to it a wealth of information about the coins in your collection. This provides you with a clear view of the contents of your collection. In addition to the main program, Exact Change includes a report editor, which allows you to create custom reports and invoices.

Using this manual

Exact Change was designed to be simple to use so that you could concentrate on your collection rather than spending hours learning a new program. This manual covers the basic operation of the program. More information about advanced functionality, such as creating custom reports, is available in electronic form on the Exact Change DVD and the Exact Change web site at www.ExactChange.Info
Installing the software

To install the software, just place the Exact Change DVD into your DVD drive and Windows will automatically load the installation program. If you have this autoload function disabled, that is, if the installation program does not automatically appear, then follow these steps…

- Double click the “My computer” icon on your Windows desktop
- Double click the icon for your DVD drive
- Double click the “Setup” icon.

The setup program will first ask you to select the language you wish to use and then proceed to ask you a series of questions such as where you’d like to install Exact Change. If you’re unsure about any of the questions, just click on “Next” to use the standard responses. If you’ve ever installed other software on a Windows machine, you’ll find the setup program to be very familiar.

The next step in the installation process is to select the countries that you want to install. What’s actually being copied to your hard drive is a series of images of the coins from each selected country. **You don’t need to install a country in order to enter coins from that country**, but Exact change will show images of only coins from those countries that are installed. If you collect only United States coinage, you may want to install just the United States, and perhaps Commemorative coinage. Beyond that, you should select the countries you wish to install based on your collecting interests, and available drive space. At any time you can run the installation routine again to add any countries you wish.

Page 2: Installing the software
Starting the program

Any time you want to start the program, click on your Windows “Start” button. Then click on “Programs” or “All Programs” (depending on your version of Windows) in the menu that appears. Finally, click on the “Exact Change” menu option. The setup program also provides the option to place an Exact Change icon on your Windows desktop for easy access to the program.
The series page

The series page provides you with a powerful tool to organize your collection in whatever way best suits your needs as a collector. It uses a file cabinet metaphor to represent each type, or series, of coin that may be present in your collection. Each file folder may contain a particular type of coin, such as an Indian cent. These folders can, in turn, be placed into another folder. So the “Indian cents” folder and the “Wheat cents” folder can be placed together into a folder titled “Cents”.

When you first start Exact Change, it automatically creates a folder for each type of U.S. coin, so you don’t have to do this manually. Of course, you can add, move, delete and rename folders to tailor Exact Change to your preferences.

Items in your collection are recorded in folders. Each folder represents a single type, or “series”, of coins. For example, Indian cents would go in one folder, wheat cents in another, and so forth. Folders can be placed within other folders to further group your coins into logical tiers. For example, “Flying Eagle cent”, “Indian cent” and “Lincoln cent” folders can be placed in a folder called “Small cents”.

All of the coin folders go into your collection, represented by a file cabinet. Typically, “Entire collection” contains folders labeled “Cents”, “Nickels”, and so forth. The Cents folder would contain additional folders such as “Indian Cents” and “Lincoln cents”.

To open a folder, or “Entire collection”, just click on the folder. If there are folders within that folder, the program will display these folders below the folder you opened. If any of these folders contain folders, you can open them as well. For example, suppose you want to look at your Indian cent collection. Click on “Entire collection” then click on “Cents”, then “Small cents” and finally “Indian head cents”.

Page 4: The series page
The folder you select here determines which items will be displayed on the other pages. For example, if you select “Buffalo nickels” on the series page, then the “Pricing” page will display prices for buffalo nickels. The “Coins” page will display all the buffalo nickels in your collection. Any reports you print on the report page will list only buffalo nickels. On the other hand, if you select “Entire collection” on the series page, then every coin in your collection will be listed in a printed report. So, the series page is the starting point where you indicate what series of coins you want to work with at this moment.

You can place coins into any folder. But it’s a good idea to have each folder contain either coins or additional folders, not both. That is, you would place your coins in a folder like “Buffalo nickels” or “Jefferson nickels” rather than placing them in the “Nickels” folder, which holds these other folders. Of course, you can do this if you wish so that you can arrange your coins however you wish.

In the lower right corner of the window are three tabs, which allow you to view information about the currently selected series...

**Image tab:**
Displays a thumbnail image of both the obverse (front) and reverse (back) of a typical coin from the selected series. Click on either of these images and Exact Change will display an enlarged image of the coin. Click on the image again to return to the normal view.

**Info tab:**
Displays narrative information and statistics about the series. Information such as metallic content and designers names is included.

**Stats tab:**
Displays information about this coin that pertains to your collection. This information includes totals for the number of coins you have or need, and the total value for those items.

Of course, you can add and delete folders as you wish, change the name of any folder, change the pictures or information associated with any folder, and move folders around to arrange your collection as you see fit. See “Customizing the program” for more information about making these changes.

Page 5: The series page
Selecting Favorite Series

Exact Change allows you to designate certain folders as favorite series. These folders are then listed in the “Favorites” menu at the top of the screen, allowing you to select that series quickly, without returning to the series page.

In the lower left corner of the series page is a checkbox labeled “Favorite series” which indicates whether the currently selected coin type has been designated as a favorite series. Simply click on this box to add or remove the checkmark. When the box is checked, you’ll see the series listed in the “Favorites” menu at the top of the screen.

You can designate any number of series as favorite series. Most people find it best to limit to a relatively small quantity the number of favorites they designate. This makes it easier to quickly find the series that are most important to them.

Helpful tip: Don’t hesitate to add series to your favorites list. By just clicking the checkbox, you can add or remove a series from your favorites list. The list doesn’t have to include only your lifetime favorites, you can use it to easily return to a particular series that you’re working on at the moment.
Detailed images

Click on either the obverse or reverse images beside the series editor to view a large detailed imaged of the selected coin type. Place your mouse anywhere over this enlarged image to view further detail from that a section of that image. Click on the image again to return to the series editor.

Viewing a coin’s size

Below the series editor is a button labeled “View size”. Click on this button to see how large the selected coin type is in comparison to various common coin types.

A red outline indicates the selected coin type’s size and shape, superimposed over a stack of common coins. Along the left side of this image, the coin’s size is display in numeric form.

If the currently selected series represents paper money, this feature will compare this note’s size to that of a U.S. dollar.

A drop-down box in the upper-left corner provides the option to select coins for this comparison. For example, you can compare the current coin type to U.S. coins or Euro coinage, whatever is available in your pocket change.

The button in the upper-left corner turns the overlay on or off. The overlay indicates which coins are displayed for comparison.

Page 7: Viewing coin details
The pricing page

The pricing page provides the ability to edit the list of year and mint mark combinations that are applicable to the type of coin in the currently selected folder. You can also edit the price information or population data for each year and mint mark combination.

Each column in the price grid represents a single year, mint mark, and variety combination. So a coin minted at two mints over a five-year period would have ten columns in the pricing grid, two columns for each year.

The row labeled “Variety” provides the ability to create multiple columns of pricing information for the same year and mint mark combination where varieties exist. Overdates are a common example of a minting variety.

Exact Change also includes an entry in each column for the “GM” or Grade Modifier. The grade modifier allows you to specify information which augments a coin’s grade. For example, copper cents are often labeled RD (red), RB (red & brown), and BN (Brown) to indicate the coin’s color. Standing liberty quarters of exceptional strike quality are labeled FH (full head) if the details of Liberty’s head are well defined by a sharp strike. In many ways, the grade modifier is similar to the variety. It differs though, in that the grade modifier designates different qualities of otherwise identical coins. Exact Change will often group coins with different grade modifiers together. For example, when calculating the number of varieties of wheat cents which exist, Exact Change reports a total of 148. There are actually 444 columns in the price list for wheat cents. There are three columns for each Year, Mint, and Variety combination, each with a different grade modifier (RD, RB, or BN). Since the only difference between the three columns is the grade modifier, Exact Change counts them as just one variety. Many certified coins are designated with a grade modifier. For example, a certified cent’s holder may indicate MS-66RD.

---

### Pricing Grid Example

<table>
<thead>
<tr>
<th>Year</th>
<th>Mint</th>
<th>GM</th>
<th>Mintage</th>
<th>Variety</th>
<th>Proofs</th>
<th>Metal</th>
<th>Silver</th>
<th>Populate</th>
<th>Serial</th>
<th>eBooks</th>
<th>Pricing</th>
<th>Coins</th>
<th>Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>1947</td>
<td>D</td>
<td>FB</td>
<td>46,835,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1947</td>
<td>S</td>
<td>FB</td>
<td>34,840,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1947</td>
<td>D</td>
<td>FB</td>
<td>34,840,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1947</td>
<td>S</td>
<td>FB</td>
<td>74,560,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

The prices shown are for the series selected on the series page.
Modifying the price list

All of the information on the price list can be modified. To avoid inadvertent changes, Exact Change includes a thumbtack button below the price list which must be clicked before changes can be made.

Exact Change is pre-configured with columns in the price grid for most collectable American coinage. So you would typically have no need to add columns to the pricing grid. This feature is included in Exact Change to allow you to enter pricing information for additional coin types you may create such as tokens. To add a new column, press the button labeled “Add”. The “Delete” button will delete the currently selected column. When the thumbtack button is up, the “Add” and “Delete” buttons will be disabled to avoid inadvertent additions or deletions.

Note: When you add a column or change the Year, mint, variety, or grade modifier information in a column, Exact Change will automatically resort the columns whenever you leave the prices page. New columns are always added on the right side of the table but they’ll automatically be sorted into the correct order.

When you add a coin to your collection, you’ll select the coin from this list. So if you’re adding a new coin series (such as foreign coins) you may want to include all year and mint combinations, even if you don’t intend to enter pricing information (the prices can be left blank if you choose).

When entering a price, simply type in the value for the selected mint and grade. Some grades may not apply to a particular type of coin. For example, price lists rarely list a G-4 value for a modern coin which was issued only in proof grades. In this case, you can simply click on the small button beside the price and select “Proof only”.

Exact Change can calculate a value for a particular grade if pricing information for that grade is not available. For example, if you enter an MS-61 value, and an MS-63 value, you can instruct Exact Change to calculate the MS-62 value as a percentage of the difference between the two. Just as you can select a value of “Proof only”, you can select values from “Split 0%” to “Split 100%”. In the above example, if you select an MS-62 value of “Split 50%”, then Exact Change would calculate the MS-62 value as being half way between the MS-61 value and the MS-63 value. You can split the values of several grades in a row and Exact Change will calculate all the unknown values.
The coins page

The coins page is where you actually enter information about the coins in your collection.

The top half of this page contains a list of the coins already entered. If you have already entered any coins, one of these coins will be selected (Highlighted with a blue bar). The information about this coin will be displayed in the boxes on the bottom of the page.

The bottom half of this page displays specific information about the highlighted coin. This is where you enter information about a new coin or modify the information about a coin you’ve already entered.

Adding and removing coin entries.

There are three buttons in the lower right corner of the coins page labeled “New”, “Clone” and “Delete”. These buttons are used to add and remove coins in your collection.

New: The new button will create a new coin entry in your collection. Once you add the coin, enter the information such as year, grade and so forth in the spaces provided.

Clone: The clone button is used to rapidly enter a number of similar coins. When you click this button, a new coin will be added to your collection by making an exact copy of the selected coin. You can then adjust any settings that differentiate the new coin from the one you copied.

Delete: The delete button removes the currently selected coin from your Exact Change collection. If you sell a coin, you can delete it from your collection, or change the coin to a sold status so that you retain a record of what happened to the coin.

Page 10: The coins page
There are 14 edit boxes which allow you to enter specific information about each coin in your collection. When you click on a coin from the list atop the coins page, a coin you've already entered, these boxes will display the information about that coin and you can make any changes you wish.

**Year, Mint & variety:** This field allows you to select the coin you’re entering. The list of available choices is taken from the price list for this coin series (see “The pricing page”). The checkbox beside each entry in the list indicates which coins are already included in your collection. This is a required field.

**Grade:** Click on the button attached to this box to indicate the grade of the coin you’re entering. This will be used by Exact Change to determine the coin’s value.

**GM:** The Grade Modifier allows you to indicate a designation, which augments the coin’s grade and may therefore affect the coin’s value. For example, copper coins have three choices for grade modifiers, RD (red), RB (red & brown), and BN (Brown). Some coin series have several grade modifier options; others have no applicable grade modifiers.

**Graded by:** This box allows you to indicate who graded the coin and is primarily used when entering certified coins. You can select from the predefined list of grading services or enter a freeform name such as “Bob”.

**Stored in:** This box is used to indicate where the coin is physically stored. You can select from one of the predefined storage methods or enter your own note, such as “Under mattress”. When you add a coin to your collection with a user defined storage location, that storage location will be added to the list of predefined storage methods.

**Date purchased:** This box is used to enter the date that the coin was purchased. Click on the button attached to this box to select a date from a pop-up calendar.

**Buy price:** This box is used to indicate the price you paid for the coin. This is not a required field, but Exact Change cannot calculate your profit or loss on this coin without this information.

**Sell Price:** This box is used to indicate the price for which you wish to sell the coin. If you don’t wish to sell the coin then you can simply leave this box empty. This information is displayed on the “Sell list” report.

**Comment:** This box is used to provide a short comment about the coin; more extensive comments should be placed in the notes field. This provides a short descriptor that can be included in a single report column.

**Mint error:** A check in this box indicates that the coin is a mint error and should therefore be included in the Mint Errors report. Mint errors are not included in the Series Checklist or Type Collection Checklist reports. Though this may seem odd, the

**Page 11: The coins page**
reason is simple; if you’re collecting a series by date and mint mark, and you obtain a specimen that’s stuck 50% off center, you’ll probably still want to obtain a normal specimen of that variety to complete your set.

**Track:** This checkbox allows you to designate specific coins within your collection that meet whatever criteria you wish. For example, you might use it to designate coins that you need to take to the next coin show. Later, you might use it to designate coins which you’ve sent to a grading service for certification. See the section labeled “Utilizing coin tracking” for more information.

**Have:** This indicates the number of coins you’re entering. You can create an entry for each coin in your collection. However, if you’re entering a roll of wheat cents, you’ll probably want to make a single entry and set “Have” to 50. If you’re entering 5 identical coins, you could make five entries, each with a “Have” value of one, or one entry with a “Have” value of 5. The decision is entirely yours. Keep in mind that if you enter multiple coins in the same entry, they must be identical. For example, if you purchase 10 identical coins today, and 10 more tomorrow, then you’ll probably want to make two entries, each with a “Have” value of ten. This is because the first lot has a different date of purchase that the second lot. A general rule is that if you’re entering large quantities of low value coins, you may want to group them as a single lot, but most people prefer to enter valuable coins each in their own entry, even if they’re identical.

**Need:** This indicates the number of additional coins of this type that you want. For example, if you are filling 10 albums and you acquire 3 coins of a given type, then you could enter 3 in the “Have” field and 7 in the “Need” field. This information is used to determine which coins should appear in your “Buy list” report.

**Sell:** This box indicates the number of coins of this type you wish to sell. This information is used to determine which coins should appear in your “Sell list” report.

**Sold:** This box indicates the number of coins of this type you’ve sold. When you sell a coin from your collection, you could simply delete the coin’s record. Or, you could change the “Have” field to zero and the sold field to one. This way, Exact Change will retain the information about the coin but won’t show it as a coin in your inventory.

**Notes:** This field allows you to enter any additional information or history about the coin. This memo is freeform and can be of any length. To the left of the “Notes” label is a small button which will enlarge the notes box, allowing you to view a great deal more of the note at one time. Click this button again to return the notes box to its normal size. Exact Change includes a built in spell checker which can be used to verify spelling in this field. See the section entitled “Spell checking” for more information.

Page 12: The coins page
Locking a coin’s value

In some instances, you may wish to lock a coin’s value at a given amount, rather than using the rate supplied by Exact Change’s price list. The most common example of this is mint errors, where the value may differ significantly from a regular coin of the same variety. You could, of course, add a column to the price list. There is, however, a simpler way to accomplish this. Above the “Buy price” and “Sell price” boxes are two checkboxes. A check in either of these boxes indicates that Exact Change should quote the corresponding value as the coin’s value. When a coin’s value is locked at either the buy price or the sell price, Exact Change will display a small padlock beside the coin’s value in the list of coins.

Sorting the coin list

The coins in the list can be sorted by any column, just click on the column headers. For example, to sort the coins by value, click the gray box labeled “Value” at the top of the column. You can sort on up to three columns by clicking each column header in the order you wish to sort. For example, if you want to sort by year and mint, then click on the “Year” column header and then on the “Mint” header. The coins will then be sorted by year, with the coins for each year sorted by mint. As you add new coins or modify existing coin entries, Exact Change will automatically sort each coin into its correct position. As you click on column headers, Exact Change will indicate the sort order by displaying numbers within the column headers. In this example, the coins are being sorted first by year, then by mint marks within each year. Finally, the coins are sorted by variety within each year and mint mark combination. Items numbers are assigned to each entry on and ever increasing basis, so you can sort on the item number column to display the coins in the order in which they were actually entered into Exact Change.

Modifying multiple coins

Multiple coins can be simultaneously selected on the coins page. Changes made to the coin information will be applied to each of the selected coins. For example, you can select a whole range of coins and change the “Grade” to modify the grade of all of the selected coins at the same time. To select a range of coins, click on the first coin that you want to select. Then hold the “Shift” key while you click on the last coin. Exact change will select both coins, as well as any coins in between them. To individually select or unselect coins, hold the Ctrl key as you click on any coins.

Page 13: The coins page
Filtering coin entries with the “View” control

Exact Change tracks four different types of coins, those you Have, those you Need, those you want to Sell, and those that you’ve Sold. The view control on the coins page allows you to specify which of these coins should be included in the list at the top of the coins page. For example, while you may want Exact Change to retain information about a coin you’ve sold, you may not want that coin to appear in the list on a regular basis.

The view control provides a check box for each type of coin. The coin list will include only coins for which the corresponding check box in the view control has been checked. For example, if only the “Have” checkbox is checked, then Exact Change will display only those coins which have a “Have” value of one or more. You may create coin entries which contain more than one of these types. For example, if you have five of a certain coin and you need four more, the coin entry could say “Have” is five and “Need” is four. In this case, the coin will appear in the list if either “Have” or “Need” is checked in the view control.

Be careful when changing the view control; a common mistake is to uncheck the “Have” checkbox and then wonder why there are no longer any coins displayed in the list. The coin entries are not gone; they’re just not being displayed because they don’t match the view filter. If you click the “Have” checkbox, all the missing coins will be displayed. If the view filter causes any coin entries to be hidden from view, it will indicate how many entries were hidden.

When you add a new coin to your collection, Exact change will change the view filter if it would otherwise prohibit the new coin from being visible. For example, if you add a coin with a sold quantity of 1, but you don’t have sold coins visible, then Exact Change will check the sold box so that the new coin is visible. This is done so that so that you can see the new coin you just added.

Page 14: The coins page
The images page

The Images page allows you to attach a picture of your coin to its entry in Exact Change. This is a great way for you to enjoy your coins even if they’re stored away in a safety deposit box. You can also attach a scanned image of your receipt.

The images on this page are associated with the coin that is currently selected on the “Coins” page. Therefore, if there are no coins entered on the “Coins” page, this tab doesn’t appear in the tabs at the bottom of the screen.

Each coin can have any number of images attached to it. To select a picture, click on one of the tabs labeled “Obverse”, “Reverse”, or “Receipt”; or click the last tab to add an additional space for another image. When you add a new image tab, a box labeled “Image label” will appear on the right, allowing you to enter a name for the new image.

Exact Change can scan in images from any device which supports the Twain standard. This includes just about any scanner, as well as many other types of devices. Of course, if you already have an image of a coin in a disk file, you can pull that image into Exact Change as well.

The Images page contains a number of tools to scan, import, and modify your coin image. Once a coin image has been associated with a particular coin, you can use the Images page to view the image at any time.

If you have more than one scanner attached to your computer, click on the “Select scanner” button to select the scanner you’re currently using. To scan in an image of the selected coin, place the coin in your scanner and click on the “Scan image” button. If you already have an image of the coin stored on your drive, click on the “Load image” button to indicate which file contains the coin’s image.
Once you’ve scanned an image of your coin and/or modified it as required, you should save the image to a file. Click on the “Save Image” button to save the current image. To erase the image of the coin, click on the “Erase image” button.

The zoom control allows you to zoom in or out, so that you can see details on the coins surface. To modify the level of zoom, select a zoom value and click on the “Zoom” button.

An image is associated when it is loaded or saved. This means that if you’re loading an image from an existing file, the association is made as soon as you load the image. When you scan an image, the association is made only when you save the image to a file.

You may wish to attach the same image to multiple coins. For example, a receipt may list several purchases on a single page. Once the image is saved to your hard drive, you can attach it to additional coins by selecting the coin and then clicking the button labeled “Load image” on the images page. This doesn’t create a second copy of the file, but merely associates the image with each coin.

In order to avoid filling your drive with images you no longer use, Exact Change will automatically erase an image’s file when you click the “Erase image” button, or remove the coin from your collection. The image file is not actually erased until you save your coin data. This allows you to discard your changes and retain the image. If the same image file is associated with more than one coin, Exact Change will not delete the image file until all the associated coins are deleted. Exact Change will always ask for confirmation before erasing unused image files. See the section entitled “Erasing unused images” for more information about this.

Image effects:

The image effects are tools which allow you to modify the image in a number of ways. You can adjust the images brightness or contrast or make other corrections such as rotating the image so that it appears upright. To apply an image effect, select the desired effect from the drop down list and click the “Apply” button. If you’re unsatisfied with the resulting image, click on the “Undo” button to reverse the effect.

Page 16: The images page
The reports page

The reports page allows you to view and print reports about the items in your collection, items you wish to sell, items you wish to acquire, or items you have sold. Exact change comes with a wide variety of reports. It also includes a Report Editor which allows you to create new reports or modify existing reports in any way you wish. Instructions for using the report editor are available on the Exact Change DVD or the Exact Change website at www.ExactChange.Info.

The reports page displays any **reports based on the series that is currently selected on the series page**. For example, if you select “Cents” on the series page, then all reports will include any type of cents, such as Indian head cents and wheat cents”. However, if you select wheat cents on the series page, then all reports will include wheat cents only. If you wish to create a report that contains all coins in your collection, then select “Entire collection” on the series page.

The report will not appear in the preview area if there are no coins included in the current report. For example, if you select the “Sell list”, the report preview will be blank if there are no items with a “Sell” value greater than zero.

The checkbox labeled “Use color in reports” determines whether your reports will appear in black & white, or in color. This box really only applies if you’re using a color printer; on a black & white printer, such as a laser printer, the images won’t print in color anyway.

You can zoom the report preview in or out to get a better view of the report being generated, or select which page of the report you’re viewing by using the controls along the bottom of the window.

Page 17: The reports page
Reports can be printed or saved to disk by simply pressing the “Print” or “Save” buttons. When you save a report to disk you’ll have the option of choosing between several formats: HTML, Acrobat, Rich Text, Microsoft Excel, or Windows BMP.

Some reports display graphs rather than standard reports. When viewing a graph you can turn the graph in three dimensions, zoom in or out, and make other adjustments until the graph appears just as you’d like. Then you can save the graph as a Windows BMP file so that it can be imported into other programs, or you can print the graph on your printer.

Other reports are designed to create a data file on your hard disk. For example, the report titled “Export coins to CSV file” will create a file on your drive that can be easily imported into other programs. When you select one of these reports, Exact Change will display information about the file to be created rather than displaying a preview of the report.

Along the right edge of the reports page is a set of tabs which allow you to view information about the report that’s currently selected. The preview tab shows the report on screen, as it would appear if you choose to print it. The description tab provides you with information about the report, what its designed purpose is, and so forth. The third tab, labeled “Report bin” is only present when you place coins in the Exact Change report bin. The next section, entitled “The report bin” discusses this subject in depth.

Page 18: The reports page
The report bin

There are times when it’s preferable to select exactly which coins will be included in a report, on a coin-by-coin basis. The most common example of this is when printing on self-adhesive labels. In this case, there may be 30 labels per page. You may want to print labels for specific coins rather than printing a label for every coin in the series. The report bin provides the capability to select specific coins to be included in a report.

In the lower-left corner of the coins page is a picture which represents the report bin. Below this picture is a number which indicates how many coins are currently in the report bin. To add a coin to the bin, drag the coin from the list at the top of the coins page and drop it on to this image. That is, click on the coin you want to add to the bin. Then, while holding down the mouse button, move your mouse cursor until it is on top of this image. Then release the mouse button. Notice that the report bin will now reflect that it contains one coin. You can also place the selected coin in the report bin by simply double clicking the report bin icon. Placing a coin in the bin does not remove its listing in the selected series and you don’t need to worry about putting the coin back later. Exact Change simply denotes the coin as one that is included in the report bin. If you add the same coin to the report bin a second time, Exact Change will actually remove the coin from the bin. So each time you drag a coin to the report bin, Exact Change toggles the coin in or out of the report bin. You can add any mix of coins from any series into the coin bin at the same time.

Once you’ve placed one or more coins in the report bin, you can view the contents of the bin by clicking on the “Reports” tab at the bottom of the screen. You’ll notice that whenever there are coins in the report bin, a new tab appears on the right side of the reports page. Click on this tab to view a list of coins currently in the report bin. If you inadvertently add the wrong coin to the report bin, you can select it on this list by clicking on it. You can then remove the coin from the bin by clicking on the “Remove selected coins from bin” button. You can remove all the coins in the bin by clicking on the button labeled “Remove all coins from bin”.

Page 19: The report bin
Not every report utilizes the report bin. For example, the “Sales sign” report pertains only to the coin currently selected on the “Coins” page. However, most reports will print either the coins in the report bin or all the coins in the currently selected series. The report bin provides you with the option to select whether the report bin will be used when printing a report.

The first option will cause Exact Change to Utilize the report bin. For example, if you print a “Collection List” report with this option selected, then Exact Change will list each coin in the report bin in the report, regardless of the series selected on the series page. The second option will cause Exact Change to disregard the report bin when printing a report, reporting instead on all the coins in the currently selected series. Exact Change never uses the report bin if it doesn’t contain any coins. By default, it will use the report bin if it does contain coins. This option allows you to put coins in the bin and yet print reports as normal.

Helpful tip: In the “File” menu, under “Options” is a menu option labeled “Automatic report bin”. When this menu option is checked, every new coin you add to your collection will automatically be added to the report bin. That way, when you add a bunch of coins to your collection you can easily print inserts for just the new coins.
The varieties page

The varieties page provides a photo gallery with descriptive text which assists you in identifying varieties. Where applicable, Exact Change will list varieties such as “Large date” and “Small date”. If you’re not sure which type of coin you have, the varieties page can help you determine the correct variety.

The box in the upper right corner of the varieties page lists all of the varieties that are depicted for the currently selected series. Simply click on a variety to view the associated image and description.

The varieties tab appears at the bottom of the Exact Change window only if there are one or more variety images attached to the currently selected series. Therefore, the varieties tab is not visible when some series are selected. If you chose not to install variety packs when you installed Exact Change, the variety tab will appear only if the Exact Change disk is currently installed in your DVD drive.

In the File menu, under Options is an option labeled Edit “Varieties”. When this option is enabled you can modify the images and descriptions on the varieties page. While the varieties page is normally visible only when there is at least one variety image for the currently selected series, it’s always visible when this option is enabled. This allows you to add variety images for a series that previously had none.

To change the image for the selected variety, simply click on the image and Exact Change will prompt you to select a new image for the currently selected variety. To edit the variety’s name, click twice on its name in the box labeled “Variety”. Note that that’s not a double click. Rather, click it once to select the variety, then click the name again to edit it.

Page 21: The varieties page
The eBooks page

The eBook page displays information from various publications that is relevant to the currently selected series.

For example, if you’ve purchased a copy of the Standard Catalog of World Coins DVD from Krause Publications, the eBook tab will display the appropriate page from the catalog whenever you select a series. No searching or scrolling is required; just select a series and click on the eBooks tab to see the page from the catalog that relates to that coin type.

An eBook is simply a combination of two files, a document file (the PDF file) and a file which contains an index to that document so that Exact Change can determine what pages in that document are relevant to each series (the eBook file).

If you have more than one eBook that relates to a particular coin type, the drop-down box at the top of the eBooks page enables you to select from a list of relevant books and page numbers. The eBooks tab will not appear unless there is at least one eBook installed which references the currently selected series.

To utilize the eBooks tab, copy the Adobe Acrobat (PDF) file into the directory where Exact Change was installed (typically c:\Program Files\Exact Change). An eBook file of the same name should also be placed in that directory. The Exact Change installation process installs eBook files for the Standard Catalog of World Coins, so all that is required is the PDF file found on the Krause Publications DVD.

When you right-click on any series on the series editor, a menu option titled “Edit eBook” offers the functionality to edit any installed eBook. You can create your own eBook file by placing any PDF file in the Exact Change directory and then using the “Edit eBook” feature to associate pages within that document to particular series within Exact change.
Loading and saving data

The file menu is used to load or save your data. Click on “File” in the upper left corner of the program window and then select from one of the following options:

**Open:** Open an existing collection file  
**New:** Create a new collection file.  
**Save coin data:** Save any collection information you’ve entered to your hard disk.  
**Save price data:** Save any changes you’ve made to the price list.  
**Save eBooks:** Save any changes you’ve made to any eBooks  
**Save all:** Save any of the above information that has been modified.

**Pricing information:**  
Exact Change saves all pricing information in Exact Change price files. These files have an “.ECP” file extension. There is one such file for each country that you may have in your collection, and a file named USER.ECP that holds pricing information for any new coin series you add yourself. Because there is a single copy of each price file, changes made to the pricing list will remain in effect if you open a different collection database.

**Collection information:**  
All the information about your collection is stored in one disk file. You can have as many of these files as you wish and you can specify any file name for your collection. For example, each member of a family can create their own collection file. In addition to the items in your collection, this file contains information about the series folders you’ve created and what information and images should be displayed for that series. So, for example, Junior’s collection may include a series for foreign coins while Dad’s collection does not. And when Junior prints a report, his prized 1909-S VDB wheat cent will be the coin displayed on the reports while Dad may choose to display his 1914-D wheat cent on his reports. In short, Exact Change wraps all of these preferences and all the information about your collection into a single file. The only thing that’s not included in this file is the images attached to coins on the images page. These are each stored in separate files so that you can easily share images with other applications.

If you make any changes to your collection, pricing information, or eBooks and then quit without saving the information first, Exact Change will notify you about the unsaved changes and provide you the opportunity to first save the changed data.

Page 23: Loading and saving data
Consider for a moment the way a word processor program loads and saves data. When you start your word processor, you’ll have a blank document. You can write a letter by starting with the blank document or you can open a letter that you’d previously written. When you’re finished, you have the option of saving your letter to disk.

Exact Change works the same way, except that instead of starting you out with a blank document, it automatically adds folders for all United States coinage. If you add a bunch of coins to your collection and then save it to disk, the coins will be there the next time you start the program only if you load your collection again.

Helpful tip: If you save your collection on your Windows desktop, Windows will create an icon on your desktop to represent that collection. If you double-click that icon, Exact Change will start up and automatically load that collection file.

Data backup strategies

It’s always a good idea to have multiple copies of your data if you’ve invested an effort in entering your collection. It’s really quite simple to make a backup; when you save your collection just save it under a different name occasionally (preferably on a different drive). For example, if you save your collection under the name “My collection”, you might want to save it as “My Collection 2”. If latter you go to a coin show and spend some time entering new coins, save it as “My collection 3”. If you always save to the same file name on the same drive, you’ll have only one copy of your data.

All of the information you enter about coins in your collection is saved into a single file with a “.ECD” extension. If you modify any prices, those changes are stored in price list files with a “.ECP” extension which you’ll find in the prices folder. If you make a number of changes to price lists, you may want to make a copy of the prices folder.
The Options menu

The options menu provides some general choices about how you want the program to behave. To view the options menu, click on the “File” menu in the upper left corner of the screen. Then click on “Options” in the menu that appears. Exact Change will remember which options you’ve selected, so that you don’t need to set the options each time you start the program.

Auto report bin: A checkmark by this item causes Exact Change to automatically place any coins you add to your collection into the report bin. This allows you to easily print reports which detail just the coins you’ve added during this session.

Reuse deleted item numbers: Normally, Exact Change assigns item numbers to each new coin in your collection in an incremental fashion. That is, when you add a new coin, Exact Change figures out what the highest item number in your collection is, and makes the new coin one number higher. A checkmark by this item tells Exact Change that if you’ve deleted any coins from your collection, it should reuse those item numbers instead. Exact Change defaults to NOT reusing deleted item numbers when the program is first installed. That way, the item number will always indicate the order in which you added each coin to your collection. However, many people prefer to organize their certified coins in plastic boxes available from the major certification services. These boxes hold 20 certified coins each. By numbering these boxes 1-20, 21-40, 41-60 and so forth, you can arrange your coins so that they can be easily located according to their Exact Change item number. If you utilize a storage system such as this, you’ll want to reuse deleted item numbers. This eliminates empty spaces in the storage boxes as you buy and sell coins.

Alternate series images: A checkmark by this item causes Exact Change to display an alternate set of images on the series page to represent each series. These images are somewhat more specific to coin collecting than the file cabinet metaphor used to introduce users to Exact Change. This option effects only the way the series page appears.

Live Spell checking: A checkmark by this option causes Exact Change to underline misspelled words as you enter a note or edit information about a series. Of course, you can right click on the note to spell check it on demand.

Scale Screen: Normally Exact Change will adjust the size of its window so that it appears the same size, regardless of your screen resolution. Turn off this option if you prefer that Exact Change not scale its size. At higher resolutions, text will appear smaller and more information can be displayed simultaneously. Changing this option takes effect the next time you start the program.
Adding countries to your collection

Exact Change includes built-in databases for coins from hundreds of foreign countries. Of course, you could create folders for coins of any country you wish. However, Exact Change spares you this hassle by providing these predefined databases, complete with images, date/mint combinations, mintage figures, and precious metal content information. **When you installed Exact Change you selected which countries you wanted to have installed on your hard drive. Even if you installed every country, Exact Change will display only coins from your own country when you first start the program.** This is an important point and one that sometimes causes confusion. You can add countries to your collection with a few mouse clicks, but by default Exact Change includes only U.S. coinage. Another family member may have their own collection and choose to add a different selection of countries.

To add a country to your collection, simply click “Add countries” in the “File” menu. You can scroll through the list of predefined countries and click on a country to add it to your collection.

You can remove a country from your collection in the same way you would delete any other folder (see “Customizing the program” for more information). If you collect only certain coins from a given country, you can delete the other series from your collection after you add a country. For example, if you collect British pennies, you could add Great Britain to your collection and then delete the folders for shillings, farthings, and so forth. If you later decide to expand your collection to include these coins, simply add Great Britain to your collection again. Exact Change will automatically recognize that your collection already includes British pennies, and it will add in just the missing series.

You can freely add and remove countries as you wish; Exact Change will automatically handle all the details like determining which price lists should be loaded. There is no harm in repeatedly adding and removing countries as you wish. You can add as many countries to your collection as you wish. At the top of the “Add Countries” menu is an “Entire world” option that adds every included country to your collection with a single click.
Erasing unused images

Each time you remove a coin from your collection, or replace an existing image with a new one, you may end up with images which were previously attached to a coin but are no longer used. This could lead to a lot of wasteful clutter on your hard drive. To avoid this, Exact Change keeps track of these images. After you save your collection, Exact Change will display a list of any images which have been rendered unused.

Sometimes, you may wish to keep an image on your drive even though it’s no longer attached to a coin in your collection. To do this, just click on the check box to remove the checkmark. When you click on the button labeled “OK”, any images with a check mark beside them will be deleted, those without a checkmark will not.

If you don’t wish to delete any of the image files, simply click the button labeled “Cancel”. Your collection information will still be saved; you’re not canceling that operation. Rather, you are simply canceling the process of deleting unused images.

Exact Change carefully tracks changes to each image as you modify your collection. For example, if you delete a coin with an image attached, and then attach that same image to another coin, Exact Change will not present that image in this list since it is still in use. If you remove a coin from your collection and its image is also attached to another coin, Exact Change will not present it as an image file to be deleted. Exact Change does not, however, check any other collection databases or other software applications, to see if the image is being used elsewhere. The drive cleanup window provides you with an opportunity to provide verification before the image files are deleted.
Using the Windows clipboard

Coin series in Exact Change can be copied to the Windows clipboard so that they can be pasted into another collection.

Simply right-click on any coin series to display the options for that series. Then click on “Copy to clipboard” or “Paste from clipboard”.

Exact Change will copy the selected series, as well as any series within that series, and any coins within those series. For example, you could copy an paste the “Nickels” folder to copy all types of nickels.

When coin series are pasted into another collection, Exact change will intelligently paste data so that there is no duplication. For example, if you paste a series that already exists within a collection, Exact Change won’t add that series again; it will simply add the coins to the existing series.
Customizing the program

The series page can be customized in many ways to help you organize your collection in the manner that best suits you. For example, if you prefer the name “Winged Liberty Dime” instead of “Mercury Dime”, you can simply change the folder’s name.

Changing a folder’s name: To change the name of a folder, right-click on the folder. A menu will appear; click on “Properties” in this menu. Changing a folder’s name will not affect Exact Change’s ability to associate the correct price list with the coins in the folder, even if you download a new price list.

Moving a series to a new position: To move a series to a different position, just hold down the Alt, Shift, or Ctrl keys (any one of them) as you click on the series to be moved and drag it to the folder that it should be placed in. When you move a series, its entire contents (coins and series) are moved right along with it. If you drag a series below the bottom of the series display, or above the top, the series display will scroll upwards or downwards. This allows you to move a series to a new position that is not visible when you begin to drag the series. If the “Auto expand” option is turned off in the display menu, you’ll be able to leave the destination series open when you select a series to be moved.

Changing a series’ images: To change the pictures associated with a coin series, just right-click on the series. In the menu that appears, click on “Change Obverse Image” or “Change Reverse Image”. Exact Change comes with images of all types of U.S. coins, but you can replace these images with your own this way. When you select a new image to represent a coin series, the selection affects only the current collection. So, each family member could have different images representing a particular coin series.

Changing the information in the “Info” tab: You can change the informational text associated with a series. That is, the text that is displayed on the “Info” tab of the series page when a series is selected. To avoid inadvertent changes, Exact Change includes a thumbtack button below the text that must be clicked before changes can be made. Then click on the text box and type the text just as you would with any word processor program. You can change the font style or color by selecting a range of text (Click on the text and drag the cursor along the text to select a range). Once you’ve selected a range of text, click the right mouse button and select “Font” from the menu that appears. This is a free form text that can be of any length. Exact Change includes a built in spell checker which will check the spelling of any text you enter here. See the section entitled “Spell checking” for more information.
Adding and removing coin series

Coin series can be added or removed, renamed and rearranged as you wish. Click on a series with the right mouse button and a menu of options will appear by the folder.

Add a series: This option allows you to create a new coin series. Exact Change will ask you to indicate the name of the folder, and the face value of the coins to be stored in the folder. You also have the option of indicating the coin’s size and shape.

On the right side of this window are two large buttons that allow you to specify where the new series will appear. The new series can be “Inside” the currently selected series, as Lincoln cents is inside Cents. Or, it can be “Below” the current series as Lincoln Cents are below Indian Cents.

Delete this folder: This option will remove the folder from the series page, after confirming your intention. All coins within the selected folder are removed from the collection as well. If the folder is not one of the standard folders automatically added by Exact Change, that is, if it’s a folder you added yourself, Exact Change will ask you whether you want the price list information from that folder deleted as well.

Empty the folder: This option will, after confirming your intention, remove all the coins from the selected folder, without removing the folder itself. If there are any folders within the selected folder, they are emptied as well.

Copy to Clipboard: This option will copy the folder and all it’s contents to a buffer, so that it can be pasted into a new collection file.

Paste from clipboard: This option is only available after you’ve copied a folder to the clipboard. It pastes the contents of the clipboard into the current collection file. Any folder in the clipboard will be placed into the folder you selected, unless a folder for that coin type already exists. In that case, the coins in the duplicate folder are simply added to the existing folder.

Select obverse image/Select reverse image: These options provide the opportunity to select a new images to represent the selected coin series.

Helpful tip: To move the entire contents of a folder to a different collection, copy the folder to the clipboard. Then open the other collection database and paste the contents of the clipboard into it. Once you’ve saved the second collection, return to the first collection and empty the folder you moved. This assures that the coins are pasted into the destination collection and the information saved, before you remove the coins from the first collection.
Customizing the layout of the coin list

You can modify the way information is displayed in the list on the “Coins” page. Click on any column header and drag it horizontally to move a column to a new position. Or, click and drag the bar between column headers to adjust the size of a column.
Also in the display menu…

Expand all: Opens all the folders on the series page so that every folder is visible at the same time. If “ Entire Collection” is selected on the series editor when you click “Expand All”, every folder in your collection will be opened. If “Quarters” is currently selected, every folder under the quarters folder will be opened.

Collapse all: Closes all the folders on the series page under the currently selected folder.

Auto expand: Determines how the series page will behave. If there’s a checkmark by this item, then a folder will open when you click on it, and any other folders will automatically close. If there’s no checkmark by this item then you must double-click on a folder to open it, and folders will be closed only when you close them. This allows you to, for example, open the cents and nickels folders at the same time. Of course, there is still only one “Currently selected series”. Exact Change will remember your preference for the auto expand option, so that you don’t need to set this option each time you start the program.

Show boxes: A checkmark by this item tells Exact Change to draw a little box beside each folder. The box will display a minus if the folder is open and a plus if the folder is closed. Clicking on this box will open or close the box. By using “Show boxes” in combination with “Autoexpand”, you can customize the display to behave in whichever way you find most comfortable. Exact Change will remember your preference for the show boxes option, so that you don’t need to set this option each time you start the program.

State quarter image: Provides the opportunity to select which state quarter’s image will be used to represent the state quarters. You can select a different state at any time, so it’s an easy way to access an image of any quarter.

America the Beautiful quarter image: Provides the opportunity to select which image will be used to represent the National Parks quarter program. You can select a different park at any time, so it’s an easy way to access an image of any quarter.

Presidential dollar image: Like the state quarters images, this feature provides the opportunity to select which coin’s image will be used to represent the presidential dollars.
Collection Themes

Some collectors prefer to collect coins with certain themes, such as coins with birds, oddly shaped coins, or bi-metallic coins. Exact Change provides a feature for these collectors to track what coins they have in their theme collection and what other coins they may wish to add.

The Info tab on the Series page displays a list of collection themes. Exact Change provides seventeen predefined collection themes. The checkbox beside each theme name indicates whether the currently selected series is part of that theme.

You can create your own themes or modify the predefined themes. When the thumbtack button is clicked down, click on a check box to add or remove the current series from that theme. To change the name of a theme, just click on a theme’s name and Exact Change will provide an edit box for you to enter the new name.

The arrow buttons to the left of the checkboxes provide an easy way to move to the next series that is part of the corresponding theme. For example, to move to the next coin with a turtle on it, click on the arrow button to the left of “Turtles”.

Page 33: Collection Themes
User defined fields

User fields give you the opportunity to track whatever information you wish for each coin in your collection. On the coins page where you enter information about each coin there are a number of boxes to enter information such as the year minted, grade and so forth. User fields allow you to add your own data entry boxes.

In the “File” menu is an option labeled “User fields”. Select the field type based on the type of information you want to enter. And then click “Add” to create the field.

Enter a description in the label box that describes what type of information should be entered. The label will appear beside the data entry box when you look at the coins page. The length setting indicates how much information you want to be able to enter into the data field.

In the above example we’ve added a data field to keep track of on-line auction numbers. “Text box” was chosen as the field type so that we can enter a series of numbers or letters. The label was set to “Auction ID” so that we’ll know what we need to type in that spot on the coins page. Finally, the length was set to 12 so that we can enter an auction ID that is up to 12 characters in length. If we click on the “OK” button and then view the coins page we’ll see that it now includes the new data entry box…

Notice the scroll bar along the right edge of the screen, you may need to scroll down to see fields you create. Any time you create a user defined field the data entry box will appear on the coins page for every coin in your collection. If you have more that one collection file, each file can have its own set of user defined fields. The fields you add are saved along with your collection. So dad can have one set of user defined fields in his collection and Junior may have a completely different set of fields. When you open a collection file, Exact Change loads the list of fields for that collection.

Page 34: User defined fields
There are eleven different types of user definable fields available…

**Text box:** Used to enter text. This is similar to the “Comments” box on the coin page.

**History drop-down:** Used to enter text. This box also provides a drop-down menu that will automatically display previous responses. This is similar to the “Graded by” box on the coins page. The “Display as top 10 list” setting tells Exact Change to include only the 10 most frequently used responses in the drop-down menu.

**Pick list:** Used to select from a pre-defined list of responses. When this type of field is added, you’ll have the opportunity to enter a list of valid responses. On the coin’s page you will be required to select one of the predefined choices.

**Text box & pick list:** Used to enter text or select from a pre-defined list of responses. When this type of field is added, you’ll have the opportunity to enter a list of valid choices. On the coins page you can either type in text or pick a pre-defined option from the drop-down menu. This is similar to the “Stored in” box on the coins page.

**Check box:** Used to enter a yes/no style checkbox. This is similar to the “Mint error” box on the coins page.

**Dollar amount:** Used to enter a dollar figure. This is similar to the “Buy price” box on the coins page.

**Date:** Used to enter a calendar date. This is similar to the “Date purchased” box on the coins page.

**Number:** Used to enter a numeric value. The length setting determines the number of digits that may be entered on the coins page. If the length is 4 or less, the coins page will display up/down buttons beside the edit box. This is similar to the “Have” box on the coins page.

**Phone:** Used to enter a phone number. Exact Change will automatically format the telephone number as it’s entered.

**Attachment:** Used to attach an file or web page to a coin. A button beside the box automatically opens the attached file or web page.

**Empty space:** Used to space other user-defined fields so that they can be grouped in a more meaningful layout.
User defined grade scales

When you enter a coin’s information into Exact Change, the grades you can select from are the standard grades of the Sheldon scale.

You may want to use a different scale for some or all types of coins. For example, some users prefer to use the Sheldon scale for coins of their native country while using a simpler scale for world coins.

The user defined grade scales enable you to define your own grading scales, and these scales can be used with any or all of the coin types in your collection file.

Click on “User defined grade scales” in the file menu. The window that appears consists of four columns; the leftmost column displays the Sheldon scale. To create your own scale, enter the grade names you wish to use in the column labeled “User scale 1”. You can leave any of the rows empty if the scale you’re creating has fewer grades than the Sheldon scale. Of course, you can enter names into the third and forth columns if you wish to create multiple user defined grade scales, but most people find that only one scale is needed. Note too that you can create up to three scales for paper money as well.

Once you’ve created a user defined scale, you can use that scale with any coin types in your collection. Right-click on a series (an item on the series editor) and select “Properties” from the menu that appears. This is the same window that’s used to define a new series. Notice that the drop-down box at the bottom of this window can be used to select which scale you’d like to use with this coin type.

Each coin type can be assigned to a particular scale; you may use the Sheldon scale for one coin type an your own scale for another coin type in the same collection.

Page 36: User defined grade scales
Changing the scale for a series changes all the series within that series,. For example, if you change the scale on “Entire collection” then it will change the scale for every coin type in your collection. If you change the scale on “U.S. coinage” then all United States coin types would henceforth use the selected scale while coin types from other countries would not be effected.

You can switch to a different scale at any time and switch back if you wish. Because you may choose to do this from time to time, it’s a good idea to place your custom grade names on a row that correlates to a similar grade on the Sheldon scale.

For example, suppose that you want to create a very simple scale that consists of just “Junk”, “Worn”, “Unc.” and “BU”. Rather than entering these names in the first four rows, you could enter “Junk” beside “G-4”, “Worn” beside “EF-40”, “Unc.” beside “MS-60” and “BU” beside “MS-64”. If you change from one scale to another at any point, Exact Change will be able to accurately correlate what grade on the previous scale correlates to which grade on the newly selected scale. This means that you can switch grading scales without having to specify the grade for the effected coin entries.
Finding a coin by item number

As you add items to your collection, the program assigns each entry a unique item number. This number can be used to quickly locate an item, by using the “Find a coin by item number” window.

To pull up this window, just click on the Help menu on the top of Exact Change and then click on “Find a coin by item number”. Simply type the desired item number into the space provided and click the OK button.

The program will locate the item you indicate, automatically change the series if necessary, and highlight the correct item on the coins or note tab. If the item you’ve indicated doesn’t match the correct view filter (Have/Need/Sell/Sold), the coin finder will add it to the list on the coins page anyway. This assures that when you enter an item number, Exact Change will take you right to that coin, regardless of whether it’s in a different series or it has been filtered from view.

Many of the standard Exact Change reports, and any custom reports you create, can include the item numbers. This allows you to quickly retrieve information about a coin which is listed in a report.

Helpful tip: To make the most effective use of this feature, you may consider writing the item number on the back of the coin holder or envelope. Small paper stickers are available at most stationary or computer stores, which are ideal for placing the item number on a certified coin’s slab. This also assures that you’re matching a given coin with its entry in Exact Change, rather than another similar coin.

Exact Change can print adhesive labels and reports which include a barcode which indicates a coin’s item number. If you have a bar code scanner, you can simply scan this barcode to go directly to that coin, much the same as the “Find a coin by item number” function.
Utilizing coin tracking

On the Coins page is a checkbox labeled “Track”. This box is used to indicate coins that match search criteria and it’s used in conjunction with the “Search & track” feature. When you do a search for certain types of coins, exact change will check this box on every coin that matches the search. You can check or uncheck this box yourself if you want to manual fine-tune the search.

When you save your collection, Exact Change also saves the tracking status of each coin. When you open your collection next time, these coins will still be tracked. This allows you to retain the results of your last search even when you exit the program.

In the Help menu is an option titled “Coin tracking” which expands the functionality of the coin tracking field beyond a simple yes/no marker. Like everything else in Exact Change, the coin tracking function is based upon the series that is currently selected in the series display.

The Track all and Untrack all options will set or clear the track checkbox for every coin within the selected series. From this same menu, you can automatically add all the tracked coins to the report bin or list them on the Windows clipboard so that they can be pasted into another program.

When there are coins in your collection that are marked as tracked, you can browse through these coins by pressing Control-T or selecting “Find next Tracked Coin” from the tracking menu. Exact Change will locate the next tracked coin in your collection, switching from one coin series to another as needed.

On the next page you’ll see how to combine coin tracking with Exact Change’s search function to achieve powerful search capabilities.
Search & Track

The Search and track options is a powerful tool for locating all the coins that match a certain criteria. For example, if you want to locate all the coins you purchased within a given date range, you can use the Search and Track function to mark all these coins as tracked.

In the help menu click on “Coin tracking” and then “Search & track”. The Search & track window provides the opportunity to designate what criteria you want to search for. These criteria are cumulative, so you can search, for example, for coins of a given grade from a certain date range and price range.

The search and track window displays the number of coins that match your search criteria. When you click the “OK” button, all of these coins will be marked as tracked. By doing another search you can track additional coins. This enables you to track, for example, coins from either of two different date ranges. If you already have coins marked as tracked you can press the button labeled “Clear existing tracks” to remove these coins from the tracking list so that only coins from your current search will be tracked.

When there are coins in your collection that are marked as tracked, you can browse through these coins by pressing Control-T or selecting “Find next tracked coin” from the tracking menu. Exact Change will locate the next tracked coin in your collection, switching from one coin series to another as needed.

An example:

A friend wants to purchase an annual set for the year 1925. You do a search with a minimum and maximum year of 1925. He wants lower mint state coins so you include that grade range in your search. Using Control-T you flip through each of the coins that were found by the search and discover that there are two dollar coins. He only needs one, so you pick one and untrack the other. Now you add the tracked coins to the report bin and you can print a list of the coins in the report bin, an annual set from 1925 in lower mint state grades.

Notice that coin tracking and the search feature work together to provide a powerful searching capability. The search feature will mark each of the matching coins as tracked. You can then browse through the tracked coins by pressing Control-T or selecting “Find next tracked coin” from the tracking menu. The results of your search are reflected in the “Tracking” box on each coin.
The bullion values calculator

The bullion values calculator provides you with information about the precious metal value of many different coins from around the world. To open the bullion values window, click on the “Help” menu at the top of the screen and then click on “Bullion values”.

Enter the current silver, gold, and platinum values in the space provided and the table will reflect the bullion value for each of the listed coins. Exact Change will save these values, even if you close the program, until you enter a new value.

The “Add a line” and “Erase a line” buttons are used to add new types of bullion coins or remove any types from the predefined list of hundreds of coin types.

Current precious metal values are reported in most daily newspapers. You can also get up to the minute prices from the Exact Change web site; there is a link on the bullion values calculator that will take you right to this information.

On the left side is a tab labeled “Conversions”. This tab provides a handy tool for converting pennyweights to grams, grams to ounces, and so forth. It can be used, for example, to calculate the melt value of a coin when it’s weight is expressing in grains.

Checking for program updates

In the “Help” menu is an option labeled “Check for updates”. If you’re connected to the internet you can simply click this menu option and Exact Change will see if there is a newer version of the program available. If there is, it will be downloaded and installed automatically. New price lists and coin types may be downloaded as well. Because installing an update may require restarting the program, you’ll be asked to save any unsaved changes before the update process begins.
Converting Hebrew dates

Israeli coins are minted with Hebrew dates. This can be an impediment for some world coin collectors because of the difficulty in determining when a coin was minted. Exact Change includes a Hebrew date converter, which will easily convert between western and Hebrew dates.

To covert an Israeli coin’s date, simply click the buttons that represent the characters in the coin’s date. The date converter will then display the standard date in the box labeled “Gregorian year”. Each Hebrew character you click on will be added to the right side of the date, pushing the leftmost character out. To clear the displayed date and start with a blank box, just click on the white box that displays the date in Hebrew. Conversely, you can type in the standard date and the date converter will automatically click the correct button and display the date in its Hebrew form.

When the date converter displays a date in it’s Hebrew form, two of the characters will be displayed in gray. These are characters which may or may not be included in the date. The double quote indicates that the characters represent a number and not a Hebrew word. On some coins this appears as a single quote mark. The final character appears in gray because it represents which millennium the coin is from. Many coins don’t include this character; it’s assumed that they’re from the current millennium.

Each letter in the Hebrew alphabet has a numeric value. The same character can represent a letter or a number. Because of this, it can be difficult to determine what writing on the coin is actually the coin’s date. Any writing on the coin could be a number, or a word. For example, the word “Israel” is written exactly like the number 10,501,030. You could mistakenly enter the coin’s denomination into the date converter, and it will diligently convert the word “Argot” to a Gregorian date (Albeit, a nonsensical date). If you select the correct Hebrew characters to represent the date and the converter gives you a ridiculous Gregorian date, reexamine the coin to determine if you’ve correctly located the date. Remember that a single or double quote indicates a numeric value.

Several characters are difficult to discern. Particularly the letters representing 4, 6, 7 and 200, and the letters representing 9, 40 and 60. This is particularly true when different fonts are used on various coin series. You’ll find that most dates include one character from the first row, one from the second, and one or more from the third.

Page 42: Converting Hebrew dates
row. The only exception is when the Jewish year ends in 15 or 16. For religious reasons, 15 and 16 are shown as a combination of (9+6) and (9+7) rather than (10+5) and (10+6).

Note that the Jewish New Year begins with Rashashana, an autumn festival, rather than on January 1st. This means a coin minted late in the year may have been minted a year before the date indicated by the converter. This is especially true of Chanukah coins, because Chanukah falls between Rashashana and January 1st. This is a rather academic point though, because the date indicated by the date converter is the one Exact Change will use to track the coin and associate it with an entry in the price list.

Understanding Hebrew numbers

With the aid of Exact Change’s Hebrew date converter, you can translate Hebrew dates with little or no understanding of how Hebrew numbers work. This section provides a basic introduction for the curious.

“Year 1” in the Jewish calendar is 3760 years prior to “Year 1” in the Gregorian calendar. Therefore, the first step in the process of converting a date from the Gregorian calendar to the Jewish calendar is to add 3760 to the year. For example, the year 2000 was year 5760 on the Jewish calendar.

Each letter in the Hebrew alphabet has numeric value. Letters are combined in groups to form other numbers. This is similar to the Roman numeral system where the letters I, V, X, L, C & M are used in various combinations to represent numeric values.

The values written on each button indicate the value of the corresponding Hebrew character. The date converter first adds these values together. For example, this sequence is 4+30+300+400, for a total of 734. This is the year on the Jewish calendar. This is actually 5734 on Jewish calendar, but the 5000 is assumed; it may or may not be included in the date. To convert it to the Gregorian calendar, we must subtract 3760 to compensate for the differences in “Year 1”. When we subtract 3760 from 5734, the result is 1974. So the date shown above is 1974 on the Gregorian calendar.

Notice that Hebrew dates are written from right to left. Because the values of the characters are added together, they could be written in any order. This differs from Arabic numbers where a digit’s position affects its value. In practice, dates are typically written with the lowest value on the left and proceeding to the highest value on the right.

Page 43: Understanding Hebrew numbers
Converting Arab dates

Many Middle Eastern coins are minted with Arab dates. This can be an impediment for some world coin collectors because of the difficulty in determining when a coin was minted. Exact Change includes an Arabic date converter, which will easily convert between a Christian Era (A.D.) date and an Arabic date.

To covert an Arab coin’s date, simply click the buttons that represent the characters in the coin’s date. The date converter will then display the standard date in the box labeled “A.D.” Each Arab character you click on will be added to the right side of the date, pushing the leftmost character out. To clear the displayed date and start with a blank box, just click on the white box that displays the date in Arabic. Conversely, you can type in the standard date and the date converter will display the date in its Arab form.

Arab dates use a different set of characters to represent the numbers zero through nine. The date those characters indicate may be according to any one of four different calendars. The Christian Era (A.D.) calendar dates from the birth of Christ. Though the date is given in A.D. format, it is unusually represented in Arab characters on the coin. The Muslim Era (A.H.) calendar dates to 622 A.D. when Mohamed fled from Mecca. It is a lunar based calendar, rather than a solar calendar. That means a year consists of twelve orbits of the moon around the earth rather than one orbit of the earth around the sun. Because of this, an A.H. year is slightly shorter than a standard year. The Arab new year, therefore, shifts slightly each year in relation to January 1st. An Arab holiday celebrated in the winter will twenty year latter end up in the summer. The Monarchic Solar (M.S.) calendar was used for a short time in the mid-1970’s in Iran. It is based on a solar year of 365 days and begins in 559 B.C. The Solar Year (S.H.) calendar is a solar based calendar of 365 days which dates to 621 A.D. This calendar is used primarily in Iran and Afghanistan. It works like A.H. dating, but it has a different starting year.

Often an Arab coin will display both the A.H. and A.D. dates, both in Arab characters. When you enter one of these dates, Exact Change can determine automatically whether you’ve entered an A.H. date or an A.D. date. It does this by assuming that any date prior to 1500 is an A.H. date and anything after that is an A.D. date. For example, if you click on the characters for 2003, Exact change assumes that that is an A.D. date and will display it as such.
Converting Japanese dates

Japanese coins don’t actually include a date. Rather, they indicate the Emperor and the year of his reign. To convert to a western date, it’s important to know what dates of each emperor’s rule. Fortunately, Exact Change takes care of this for you.

This symbol translates to “Year” can help you identify the year on the coin because it always appears on the left or right of the date. It may appear on either side because early coins were written right to left and since 1948 coin dates have been written left to right (don’t worry, exact change takes care of that for you as well).

Each emperor is represented by two characters which are displayed as you click on the “Back” and “Next” buttons to scroll through the list of emperors. These characters will be on the opposite end of the date from the year symbol.

Between the year symbol and the Emperor’s symbols will be from one to three characters. These characters in the middle may be Japanese characters or western characters depending on the type of coin you’re look at. Just scroll through the scroll box on the right side of the date converter until you see these 1-3 characters and the western date will be listed to the right.
Converting Nepal dates

Coins of Nepal are minted dated according the V.S. (Bikram Samvat) era and use Nepalese characters. Because different scripts are used on some coins, Exact Change includes a box labeled “Show alternate character styles”. When this box is checked the display will show alternate representations of 1, 5 and 9.

Converting Thai dates

Coins of Thailand are minted with Thai dates. They use a different set of characters to represent the numbers zero through nine, and are dated according to the Buddhist Era (B.E.) which dates from 543 B.C.

Converting Bengali dates

Bangladeshi coins are minted with Bengali dates. The Bengali date converter is the simplest of Exact Change’s date converters. This is because Bengali coins are dated according to the standard Christian Era (A.D.) calendar; they simply use a different set of characters to represent the numbers zero through nine.
Converting Taiwanese dates

Coins of Taiwan are minted with Chinese dates. The Taiwan date converter is similar to the Japanese converters except that it shows four characters that indicate “Republic of China” where the Japanese coins indicate the emperor. Like their Japanese counterpart, Taiwanese coins begin with a symbol that translates to “Year”. They are dated from the establishment of the republic of China in 1911. Dates from 1949 and before indicate China while subsequent dates indicate Taiwan. This is because when the communists took over China in 1949, the Nationalist government retreated into exile on the island of Taiwan.

Converting Burmese dates

Coins of Myanmar (Formerly Burma) are minted with Burmese dates. They use a different set of characters to represent the numbers zero through nine, and are dated according to the Chula-Sakarat (C.S.) era which dates from 638 A.D.
Converting Roman Numbers

Many coins contain a roman numeral as part of their design. This may indicate the date, the denomination, or the year of a ruler’s reign. Exact Change’s roman number converter makes it easy to convert between Roman and Arabic numbers.

To convert an Arabic number to Roman, just type the number into the space labeled “Arabic”. As you type, the Roman equivalent will appear in the space labeled “Roman number”. To convert the opposite direction, just type the roman number into the space labeled “Roman number” and the equivalent value will appear in the space labeled “Arabic”. If you enter a roman number that is not properly formatted, the converter will display a message indicating the problem. If possible, Exact Change will convert the number anyway and display the properly formatted Roman number as well as the Arabic equivalent.

Understanding Roman Numbers

_This information is intended to provide you with some background, it’s not necessary to understand how Roman number work in order to use the Roman number converter._

There is no Roman number smaller than one. Ancient Romans did not recognize the concept of zero or negative numbers. Roman numbers are comprised of six letters M, D, C, L, X, V & I. Each has a value which is listed in the above image. To convert a Roman number, the value of each letter is added together. For example, XVI is equal to 16 (10+5+1).

When a smaller number appears to the left of a larger number, the smaller number is subtracted from the larger number and that sum is added to the total. For example, XIV is equal to 14 (10+5-1). The order in which the characters appear therefore affects their value. Only powers of 10, that is I, X, C & M (1,10,100 & 1000) can be placed before a larger number to indicate a subtraction. For example, 45 would be written as XLV (50-10+5) rather than VL (50-5). Only one smaller digit can be placed before a larger digit to indicate subtraction. For example, the number 30 would be XXX (10+10+10), not XXL (50-10-10).

A letter may be repeated in order to indicate a larger number. For example, XXV is equal to 25 (10+10+5). Only powers of 10, I, X, C & M (1,10,100 & 1000) can be repeated. So 150 should written as CL (100+50) rather than LLL (50+50+50). A letter should be repeated no more than three times. For example, the number four would be written as IV (5-1) rather than IIII. For higher numbers, a bar can be placed over a letter to indicate that it should be multiplied by one thousand. For example, a V with a bar above it indicates 5000. This is why the converter works on numbers from 1 to 3999, higher numbers would require the use of bars and are not generally used for any numismatic purpose.

Page 48: Converting Roman numbers
The Wallpaper Press

The Wallpaper Press is a program that is included on the Exact Change CD. It produces a wall-sized coin image which can draw attention to your next coin show booth, or add a numismatic flair to your den remodeling job. It does this by printing small sections of the coin image, each section on a different piece of paper. The pages can then be tiled together, like wallpaper, to create a huge image which will cover an entire wall.

Upon closer inspection, you’ll notice that the larger image is actually made up of thousands of smaller coin images. Each dot, or pixel, that makes up the large image is actually itself a coin image. The program uses the term “Major image” to describe the large image and “Minor image” to describe the coin image which represents a single dot in the larger image.

The first step in creating wallpaper is to select the images to be used. Click the “Load image” button beneath either image to specify a file which contains the desired image. Beneath the minor image is a check box labeled “Random”. You may check this box rather than specifying a minor image. If you do, the Wallpaper Press will randomly select different coin images for each dot that makes up the major image.

The next step is to specify how large you want the resulting wallpaper to be. There are two factors that determine the size. The first is the number of dots that make up major image. The second is the number of dots (the number of minor images) that will be printed on each page. For example, if the major image is 288 dots wide, and you print 32 minor images across each page, then the resulting image will be 9 pages wide (because 288 divided by 32 is 9).

In the “Image size” box you can specify how wide the original image should be. It doesn’t matter how wide the image actually is, the program will scale the major image so that its width is whatever you specify in this box.

In the “Dots per page” box you can specify the number of minor images which will be printed on each page. A smaller number in this box causes each minor image to be printed larger (because there are fewer on each page) and also causes the resulting image to appear larger.

Beside these boxes, the program displays the total number of tiles (number of pages) which will be produced. If the “Image size” is not evenly divisible by the “Dots per page”, the program will recommend changing the image size. You don’t have to change the size, but if you follow this recommendation, you’ll avoid finished wallpaper that has half a sheet along the edge and is, for example, nine and a half pages wide.
The Wallpaper press works with square images, where the height of the image is the same as the width. If the images you specify are not square, the program will automatically stretch the image to make it square. This is why you’re not required to enter both a height and width for the image.

The two drop-down boxes which say “Print all columns” and “Print all rows” are used to specify which tiles you wish to print. For example, if the tiles in row 5 of your wallpaper were somehow damaged, you could reprint just that row of tiles by selecting “Print all columns” and “Print row 5”. These options allow you to select any row (horizontal series) or column (vertical series). You can also reprint a single tile by selecting a combination like “Print column 3” and “Print row 5”. This would cause the program to print only the one tile which is 3\textsuperscript{rd} from the left and 5\textsuperscript{th} from the top.

There are two checkboxes which affect the way each tile is printed. “Print outline” will cause a thin line to appear around the tile where the page should be trimmed. This option can be very helpful when you assemble the wallpaper together. The other option, “Print tile numbers” will cause the program to print the column and row number on each page. This too can be very helpful when you assemble the resulting wallpaper.

When you press the “Print” button, the Wallpaper Press will begin to print your wallpaper. It may take some time to create the wallpaper; an image which is nine pages wide and nine pages tall requires 81 pages of printed output. Such an image may require hundreds of gigabytes of image information to be loaded and image processed.

The trick to creating quality wallpaper is the balance between the major image’s size, and the number of dots per page. If the major image is too small, the wallpaper’s overall image will lack detail. If the minor images are too small, then they will lack detail. However, if you increase the size of either type of image, the resulting wallpaper will grow in size. If your printer produces an output of 1200 DPI (dots per inch) or more, then you can print more minor images on each page while producing minor images which are still identifiable.

\textbf{Helpful tip:} When you check the “Random” box, the program randomly selects from the images installed on your hard drive. If you chose not to install a lot of images, you can run the copy on the wallpaper press program located on the Exact Change CD. This will allow the program to randomly select from the thousands of images on the CD-ROM.
Here, the author’s dog lounges in front of a Mercury Dime photomural created with the Exact Change Wallpaper Press.

This image is 6 feet wide and consists of 82944 small images. Each of these images represents one dot in the overall image of the mercury dime. The mural was printed on 81 pieces of paper which were then tiled together.
The Report Press

The Exact Change report press is a program that is included with Exact change. It provides the ability to modify any report or create your own custom reports.

Of course, you may never need to modify any reports since Exact Change includes a large variety of reports. But the report press provides the ability to place your company logo on invoices to create a professional look or create entirely new reports. When you create a new report, you can easily share it with other Exact Change users if you wish.

Use of the report press requires a basic understanding of the Exact Change program. Once you’re comfortable with Exact Change’s features, check the Wild Man Software web site for full documentation and further information about the Report Press.
Exact Change
Copyright 2010 by Wild Man Software

Copyright Notice
No part of this documentation or the enclosed software may be reproduced by any means without the express written permission of the author. This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal penalties and will be prosecuted to the maximum extent possible under law.

Disclaimer
This software product is provided as is, without warranty of any kind, either expressed or implied, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. The entire risk as to the use of this product is assumed by the user. Neither the author, nor any distributor assumes any liability for direct or indirect damages including any lost profits, lost savings, or other incidental or consequential damages arising from any defects, or the use or inability to use this product, even if said party has been advised of the possibility of such damages. Under no circumstances shall the liability of the software exceed the initial license fee.

The images included with the enclosed software application are protected by embedded watermarks using Digimarc image protection technology.
“Exact Change is always appreciated”
-Metro bus driver

Coin collecting software should be for the study of coins, not the study of software manuals. It should be a tool that enhances your enjoyment of your collection rather than forcing you through the drudgery of endless data entry. It should help your collection “Come alive” as it immerses you into a world of imagery and information. It should instill a feeling that this coin in your hand is a piece of history, not just a chunk of metal to be cataloged.

Now it will... Exact Change